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1
Introduction to the Dolby Atmos Panner
Plug-in Guide
This documentation describes how to work with the Dolby Atmos Panner plug-in, which is designed by
Dolby for use with Dolby Atmos home theater content in Avid Pro Tools.
•
•
•

About this documentation
About the Dolby Atmos Panner plug-in
Contacting Dolby
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Introduction to the Dolby Atmos Panner Plug-in Guide

1.1 About this documentation
This documentation provides information for using the Dolby Atmos Panner plug-in.
This documentation is for engineers and sound designers who author Dolby Atmos sound and create
Dolby Atmos masters.

1.2 About the Dolby Atmos Panner plug-in
The Dolby Atmos Panner plug-in was required for Dolby Atmos home theater workflows running on
Dolby Atmos systems with Pro Tools versions earlier than Pro Tool v12.8.
With the release of Pro Tools 12.8 (which included native 7.1.2 tracks, object/bus toggle, object mapping,
and native panning automation for Dolby Atmos) the Dolby Atmos Panner plug-in is no longer required for
home theater workflows, and is typically no longer used.
The plug-in is included with the Renderer installer primarily to support older Pro Tools sessions that need to
be used with more recent versions of Pro Tools.
The recommended workflow on opening an older session that uses the Dolby Atmos Panner plug-in is to
convert the Dolby Atmos Panner plug-in to Pro Tools native panning automation, save the session, and then
remove the Dolby Atmos Panner plug-in. While the conversion of panning automation is bi-directional
between Pro Tools and the Dolby Atmos Panner plug-in, it is recommended to use native Pro Tools panning
automation to ensure future compatibility.
Note: In Pro Tools, do not mix Pro Tools native panning for Dolby Atmos and Dolby Atmos Panner
plug-ins in the same session.

1.3 Contacting Dolby
You can contact Dolby regarding this product and its supporting documentation.
If you have technical questions about this product, contact your reseller and visit https://
developerkb.dolby.com/support/home.
If you have questions or comments about this documentation, please send an email to
documentation@dolby.com.
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2
Positioning objects in a Dolby Atmos mix
Position objects in a Dolby Atmos mix by writing panner automation parameters to object tracks in
Pro Tools.
•
•
•
•
•
•
•
•
•
•
•
•

Automating panner controls
Automatable controls
Changing object location
Using Elevation mode
Elevation snap modes
Using ceiling elevation
Using sphere elevation
Using wedge elevation
Using Speaker Snap mode
Managing speaker zones
Changing object size
Z coordinate and Dolby Atmos Panner controls
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Positioning objects in a Dolby Atmos mix

2.1 Automating panner controls
You can automate many of the Production Suite panner plug-in controls in Pro Tools. The recorded (written)
automation for these controls defines the metadata that is sent to the Renderer for rendering a Dolby Atmos
mix (or for re-rendering to a surround format).
Procedure
1. Enable plug-in automation for the session by performing these steps in Pro Tools:
a) Choose Window > Automation.
b) Click (enable) the Enable Plug-in Automation option in the Write Enable section of the Automation
window.
2. Enable plug-in automation parameters in each panner plug-in by performing these steps:
Note: Skip this step if you enabled Plug-in Controls Default to Auto-Enabled prior to adding
Production Suite panner plug-ins to the session.
a) Open a panner plug-in.
b) In the panner plug-in window, Command + Option + Control the automation button at the top of the
plug-in window to enable all automatable plug-in parameters.
Alternatively, you can click on the automation plug-in window, and then add parameters individually.
3. Prepare each object track for recording panner automation by performing these steps:
a) In each object track, set the automation mode to Write (or one of the other automation record
modes).
To set all object tracks at once, select each object track, and then use Shift + Option when setting the
automation mode.
b) Optional: In the edit window, display automation lanes for each panner parameter in an object track
by clicking show/hide lane, and then adding each parameter lane.
To display lanes for all object tracks at once, select each object track, and then use Shift + Option
when clicking show/hide lane and adding lanes.
4. Start playback, and automate panner controls as desired.
You can change panner parameters using any of the available methods to control the panner (such as
using a joystick).
5. When done recording automation, stop playback.

2.2 Automatable controls
The Dolby Atmos Panner plug-in supports automation of its primary controls, including those for positioning
an object. Configuration settings are not automatable
Most standard Pro Tools plug-in and automation controls are available for the plug-in.
Refer to Pro Tools documentation for additional information on working with plug-ins, including:
•
•
•

Inserting plug-ins on tracks
Plug-in window controls
Automating plug-ins

Dolby Atmos Panner automatable controls
Bypass (master bypass)
Bypass status for plug-in metadata (on or off). When set to on, audio from the object track continues to
output from the Dolby Atmos Renderer.
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Changing object location

Pan X
Pan location in the x (left/right) dimension (-100 to 100).
Pan Y
Pan location in the y (front/back) dimension (-100 to 100).
Pan Z
Pan location in the z (top/bottom) dimension (0 to 100).
Size
0 to 100.
Elevation
Elevation status (on or off).
Elevation snap
Elevation Snap mode states (ceiling elevation, wedge elevation, sphere elevation, or off).
Snap
Speaker Snap mode status (on or off).
Zones
Active speaker zones (back only, front only, three, five back, five, and seven).

2.3 Changing object location
Sliders in the panner plug-in let you adjust the location of the object.
About this task
•

X, Y, and Z sliders let you adjust the location of the object in the virtual room, through all three
dimensions: x (left/right), y (front/back), and z (top/bottom).
Dolby Atmos Panner additional information: When Elevation mode is off (elevation button not
highlighted), you can adjust x and y coordinates, but you cannot adjust the z coordinate. When Elevation
mode is on, you can also adjust the z dimension. In Ceiling and Wedge Elevation Snap modes, the z
coordinate is generated from the y coordinate only, and changes as the y coordinate is changed. In
Sphere Elevation Snap mode, the z coordinate is generated from x and y coordinates, and changes as
they are changed.

You can use a mouse, joystick, control surface, enabled automation, or keyboard entry to adjust the
location. As sliders or position display values are adjusted, the pan location cursor in the plug-in window
moves accordingly. Inversely, the sliders and position display values update when the cursor is adjusted.
You can place or pan an object from any location in the panner window to any other location.
Respective position displays provide the value (or coordinates) of the current object position, whether
moving the pan location with a mouse, joystick, control surface, enabled automation, or keyboard entry.
Note: If the sliders and their position displays are not visible at the bottom of the plug-in window,
click the Done button in the Configuration Options section to close the options and reveal the
sliders and their values.
Procedure
Perform one of these steps:
•
•

Click the slider button, and drag to the desired coordinate.
Click in the slider range to jump to a new coordinate.
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Positioning objects in a Dolby Atmos mix

•

Type a valid value in a slider position display, and press Enter.

2.4 Using Elevation mode
Elevation mode lets you manually adjust the z (top/bottom) dimension in the Dolby Atmos Panner virtual
room.
About this task
When on (elevation button highlighted), two overhead zones are made active in the room (and are displayed
as two blue squares left and right of the center of the room). Elevation mode is on by default.
Elevation mode forms a flat ceiling across the virtual room. The elevation z coordinate is not linked to x and
y coordinates, and is adjusted independently. You can adjust the elevation across the room with a joystick,
control surface, mouse, or enabled automation.
Procedure
1. Turn on Elevation mode by performing one of these steps:
•
•
•

Click (highlight) the elevation button.
Use a control surface.
Use a joystick.

2. Adjust elevation (the Z setting) using any of these:
•
•
•

Control surface
Joystick
Mouse (with the Z slider)

You can automate Elevation mode on and off in Pro Tools by using the Elevation mode automation
playlist.

2.5 Elevation snap modes
Elevation Snap mode refers to the automation playlist that supports modes that change the shape of the
ceiling in the room, and in turn, how z values for elevation drop as they move away from the middle of the
room.
•
•
•

Ceiling elevation gives the room a flat ceiling in the back 80% of the room and a curving ceiling from the
front 20% of the room to the screen.
Sphere elevation gives the room a domed ceiling.
Wedge elevation gives the room a peaked ceiling.

You can automate Elevation Snap modes in Pro Tools by using the Elevation Snap mode automation
playlist. Elevation Snap mode has four states: ceiling elevation, wedge elevation, sphere elevation, and off.

2.6 Using ceiling elevation
Ceiling elevation links the z elevation to the y coordinate to form a flat ceiling inside the Panner virtual room
that curves from the front 20% of the room to the screen.
About this task
The elevation is constant in the back 80% of the room. Elevation drops uniformly as objects are moved away
from the front 20% of the room to the screen. Left or right movements on the x-axis do not change the object
elevation.
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Using sphere elevation

Procedure
1. Turn on ceiling elevation by performing one of these steps:
•
•

Click the elevation snap selector, and select (highlight) the ceiling elevation icon.
Use a control surface.

2. Adjust elevation by moving the y coordinates with any of these:
•
•
•

Joystick
Control surface
Mouse (on the pan location cursor or Y slider)

You can automate ceiling elevation on and off in Pro Tools by using the Elevation Snap mode automation
playlist.

2.7 Using sphere elevation
Sphere elevation links the z elevation to the x and y coordinates to form a hemispheric dome inside the
Panner virtual room.
About this task
The highest point of the dome is the exact center of the room. Elevation decreases uniformly as you move
away from the center in any direction. Elevation drops to the bottom at the four points where the
hemisphere meets the virtual walls.
Procedure
1. Turn on sphere elevation by performing one of these steps:
•
•
•

Click the elevation snap selector, and select (highlight) the sphere elevation icon.
Use a control surface.
Use a joystick.

2. Adjust elevation by moving the x and y coordinates with any of these:
•
•
•

Mouse (on the pan location cursor or X and Y sliders)
Control surface
Joystick

You can automate sphere elevation on and off in Pro Tools by using the Elevation Snap mode
automation playlist.

2.8 Using wedge elevation
Wedge elevation links the z elevation to the y coordinate to form a peaked ceiling inside the Dolby Atmos
Panner virtual room.
About this task
The highest elevation is a line running left and right at the center of the room. Elevation drops uniformly as
objects are moved away from that center line on the y-axis toward either the front or back of the room. Left
or right movements on the x-axis do not change the object elevation.
Procedure
1. Turn on wedge elevation by performing one of these steps:
•
•

Click the elevation snap selector, and select (highlight) the wedge elevation icon.
Use a control surface.
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Positioning objects in a Dolby Atmos mix

•

Use a joystick.

2. Adjust elevation by moving the y coordinates with any of these:
•
•
•

Mouse (on the pan location cursor or Y slider)
Control surface
Joystick

You can automate wedge elevation on and off in Pro Tools by using the Elevation Snap mode automation
playlist.

2.9 Using Speaker Snap mode
Speaker Snap mode moves object audio to the active speaker nearest its established location during
playback.
About this task
At the Renderer, this ensures that 100% of the audio signal is routed to the single speaker that is nearest to
the current spatial placement. The location of the speaker that the object snaps to is based on the current
room configuration (defined by the .dac file, located on the Renderer), and can vary from one room to
another. Speakers in inactive zones are ignored in Speaker Snap mode.
Speaker Snap mode does not move the pan location cursor in the virtual room.
Speaker Snap mode is useful for eliminating phantom panning. For example, in the Dolby Atmos Panner
default mode (Speaker Snap mode off), the algorithm might spread the audio of one object across two or
more speakers. Speaker Snap mode prevents this by snapping all of the audio to the single speaker nearest
the indicated position of the object in the Panner virtual room.
Note: For a visual representation of which speaker the audio snaps to, look at the room
configuration in the Dolby Atmos Monitor application.
When Speaker Snap mode is on, object size is disabled.
Procedure
•
•
•

Click (highlight) the speaker snap button.
Use a control surface.
Use a joystick.
You can automate Speaker Snap mode on and off in Pro Tools by using the snap automation playlist.

2.10 Managing speaker zones
Zones in the Dolby Atmos Panner plug-in define which speaker or speaker zones (excluding overheads) are
active for the object, as the Renderer interprets the object metadata.
About this task
Zones are also used when the Renderer re-renders the Dolby Atmos mix to a surround format (such as 7.1 or
5.1 channels). Zones can be useful to isolate (or dedicate) an object to a specific speaker or group of
speakers.
Inactive zones are effectively muted for live monitoring or master recording. Additionally, speakers in
inactive zones are ignored in Speaker Snap mode.
Zones are displayed in the virtual room as blue squares in their relative position. Zones on the room outline
represent the L, C, R, Lss, Rss, Lsr, and Rsr speakers or speaker zones. Zones are active (teal) or inactive
(gray), based on the setting of the zones button.
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Changing object size

Zones work in conjunction with Elevation mode and Elevation Snap mode, which activate the overheads for
use while panning.
Provided zones include:
Back only
Enables Lss, Rss, Lsr, and Rsr zones
Front only
Enables L, C, and R zones
Three
Enables C, Lsr, and Rsr zones
Five B (back)
Enables L, C, R, Lsr, and Rsr zones
Five
Enables L, C, R, Lss, and Rss zones
Seven
Enables L, C, R, Lss, Rss, Lsr, and Rsr zones
Procedure
Change the current zone in the panner by performing one of these steps:
•
•

Click the zones button in the panner, and select a zone.
Use a control surface.

You can automate zones in Pro Tools by using the zones automation playlist.

2.11 Changing object size
The object Size slider lets you spread audio for an object across the room, based on the current object
position and active speakers in the room.
About this task
You can use a joystick, control surface, mouse, enabled automation, or keyboard to adjust the size (or
spread). The object size outline, which surrounds the object cursor in the virtual room, shows the current
spread for an object. The object size has a range of 0 to 100.
Note: If the Size slider and value display are not visible at the bottom of the plug-in window, click
the Done button in the Configuration Options section to close the options and reveal the slider and
its value.
Procedure
•
•
•

Click the slider button, and drag to the desired coordinate.
Click in the slider range to jump to a new coordinate.
Type a valid value in the slider value display, and press Enter.

2.12 Z coordinate and Dolby Atmos Panner controls
When using the Dolby Atmos Panner, the Z coordinate and how it renders can be affected by other controls.
•
•

When changing object size, the Z slider position, its display value, and the z automation playlist always
match.
Z items always represent the overhead level that is displayed in both the plug-in user interface (UI) and
the Monitor application. However, there are situations where the rendered audio output may not match
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Positioning objects in a Dolby Atmos mix

•

the z position being displayed. For example, if you disable Elevation mode after writing z automation,
audio will play back rendered without overheads, but the plug-in UI will continue to display the z
automation.
There are also situations where the z automation UI and rendered audio output do not update during a
write automation pass as expected. If you enable an Elevation Snap mode during a write automation
pass, the z automation and elevation amount will not update until new automation data for the
corresponding slider is written. For example, when you enable Sphere Elevation Snap mode, updates
occur after new x or y automation data is written.
Note: After authoring a Panner plug-in with Elevation mode or an Elevation Snap mode on, you can
edit the z automation data that was recorded by using a pencil tool in the z automation playlist. The
elevation defined by the new automation will be applied to the rendered object audio in the
subsequent playback as long as Elevation mode is enabled.
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3
Managing panner plug-ins
Panner plug-in windows provide controls to bypass the plug-in, access configuration options, resize
the window, or relink stereo versions of the plug-in.
•
•
•
•

Bypassing panner plug-in metadata
Accessing panner configuration options
Linking stereo panner plug-in controls
Resizing a panner plug-in window

Dolby Atmos Panner Plug-in v2.5.x Guide
23 May 2019

15

Managing panner plug-ins

3.1 Bypassing panner plug-in metadata
The Bypass switch in a panner plug-in header effectively stops plug-in metadata from being sent to the
Renderer.
About this task
When the Bypass switch is on, metadata no longer routes to the Dolby Atmos Renderer. However, all audio
from the object track continues to output from the Dolby Atmos Renderer.
You can automate bypass on and off in Pro Tools by using the master bypass automation playlist.
Procedure
Enable the Bypass switch in a panner plug-in.

3.2 Accessing panner configuration options
Dolby Atmos panner plug-ins include a configuration option area for manually assigning an object number
and configuring a joystick to control pan positioning. This area also displays the Renderer connection status.
Procedure
Click the configuration options button in the panner window.

The Configuration Options area displays.

Figure 1: Configuration options area

3.3 Linking stereo panner plug-in controls
With stereo panner plug-ins, you can adjust controls on each channel independently (unlinked), or linked to
either copy or mirror actions made on the other channel.
About this task
Note: You cannot automate the Linking setting. To pan material with one option and then switch to
another, do separate automation record passes.
Avid D-Command and D-Control work surfaces support using a stereo panner plug-in linking control to
change the x-, y-, or z-axis position of the two objects in a stereo object.
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Resizing a panner plug-in window

Procedure
1. Open a stereo panner plug-in.
2. Click the Linking selector, located between the Left and Right channel controls at the bottom of the
plug-in window.

3. Select None, Mirrored, or Copy.

None
The Left and Right channel controls operate completely independently. Actions taken in one channel
do not affect the other.
Mirrored
Any action in one channel automatically places its mirror image in the other. For example, panning from
center to the left in the Left channel produces a pan from center to right in the Right channel.
Copy
Any action in one channel is copied to the other. For example, panning from the center to the left in the
Left channel also produces a pan from center to left in the Right channel.

3.4 Resizing a panner plug-in window
You can resize a panner plug-in window, including returning it to its default size.
Procedure
Perform one of these steps:
•
•

Drag the lower-right corner of the window to change the size of the window. Drag downward or to the
right to increase the size of the window, or upward or to the left to decrease the size of the window.
If you want to return to the default window size, perform one of these steps:
•
•

Drag the lower-right corner fully upward and to the left until the window no longer changes size.
Delete the preferences file (com.dolby.panner.aax.plist), located at /Library/Preferences.

Results
After you resize a panner plug-in window, the new size is applied to subsequently opened panner plug-ins
until you do a new resize.
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Controlling panner plug-ins with different hardware

4
Controlling panner plug-ins with different
hardware
You can control a Dolby Atmos panner using different hardware.
•
•
•
•
•

Using a mouse to position an object
Using a keyboard to position an object
Panning with a supported JLCooper controller
Control surface and mixing console support
Generic MIDI support
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Using a mouse to position an object

4.1 Using a mouse to position an object
You can use a mouse to position the object (pan location cursor) precisely.
Procedure
•
•
•
•

Click and drag the pan location cursor, which represents the object.
Click and hold on another location in the room to move the object to that location.
In a slider, click the slider button and drag to the desired coordinate.
In a slider, click in the slider range to jump to a new coordinate.

4.2 Using a keyboard to position an object
You can use a keyboard to position an object (pan location cursor) precisely.
Procedure
•

Type a valid value in a slider position display, and press Enter.

4.3 Panning with a supported JLCooper controller
You can control a panner plug-in with any supported JLCooper controller. These include the JLCooper Axos
surround panner, the JLCooper Eclipse PX surround panning joystick controller, and the JLCooper MCSPanner.
About this task
When the joystick has been prepared, you can use it to grab the object (pan location cursor) and position it
anywhere in the panner virtual room.
Procedure
1. Open the plug-in window so that it is in focus.
2. Perform one of these steps:
•
•

For a controller with a button on the top of the joystick, press and hold the button, and then move the
joystick.
For the JLCooper Axos panner, move the joystick. You can also use the joystick switches and knobs to
determine other panner behaviors.

The switch and knob behavior for each panner plug-in and supported JLCooper panner is different.

4.3.1 Dolby Atmos Panner and JLCooper joystick switch and knob reference
You can use JLCooper joystick switches and knobs to determine different Dolby Atmos Panner behaviors.
The switch and knob behavior for each supported JLCooper panner is different.
JLCooper Axos switch and knob reference for the Dolby Atmos Panner
•
•
•
•
•
•
•

Prev Track: Toggle Elevation and Elevation Snap modes on and off.
Target Up: Set Wedge Elevation mode so that the mode enables when S1 is on.
Target Down: Set Sphere Elevation mode so that the mode enables when S1 is on.
Next Track: Set Ceiling Elevation mode so that the mode enables when S1 is on.
Right Pan: Toggle Speaker Snap mode.
Front Pos and LFE: Modify elevation in Elevation mode. Turning to the right elevates the object in the
audio field; turning to the left lowers the object in the audio field.
F/R Pos: Modify size. Turning to the right decreases the size; turning to the left increases the size.

Dolby Atmos Panner Plug-in v2.5.x Guide
23 May 2019

19

Controlling panner plug-ins with different hardware

JLCooper Eclipse PX switch and knob reference for the Dolby Atmos Panner
•
•
•
•
•
•
•
•

S1: Toggle Elevation and Elevation Snap modes on and off.
S2: Set Elevation mode so that the mode enables when S1 is on.
S3: Set Wedge Elevation mode so that the mode enables when S1 is on.
S4: Set Sphere Elevation mode so that the mode enables when S1 is on.
S5: Set Ceiling Elevation mode so that the mode enables when S1 is on.
S6: Toggle Speaker Snap mode.
E1 and E3: Modify elevation in Elevation mode. Turning to the right elevates the object in the audio field;
turning to the left lowers the object in the audio field.
E2: Modify size. Turning to the right decreases the size; turning to the left increases the size.

JLCooper MCS-Panner joystick switch and knob reference for the Dolby Atmos Panner
•
•
•
•
•
•
•
•

S1: Toggle Elevation and Elevation Snap modes on and off.
S2: Set Elevation mode so that the mode enables when S1 is on.
S3: Set Wedge Elevation mode so that the mode enables when S1 is on.
S4: Set Sphere Elevation mode so that the mode enables when S1 is on.
S5: Set Ceiling Elevation mode so that the mode enables when S1 is on.
S6: Toggle Speaker Snap mode.
E1 and E2: Modify elevation. Turning to the right elevates the object in the audio field; turning to the left
lowers the object in the audio field.
E3: Modify size. Turning to the right decreases the size; turning to the left increases the size.

4.3.2 Installing and configuring a JLCooper MCS-Panner joystick
Before you can use an MCS-Panner joystick to control a panner, you must install the joystick to a MIDI
interface on the computer running Pro Tools for Dolby Atmos.
Procedure
1. Obtain a suitable Universal Serial Bus (USB) MIDI interface. It must have at least one set of female MIDI in
and out connectors.
2. Install the USB MIDI interface on the Pro Tools computer. Refer to the interface documentation for
installation and configuration requirements.
3. Configure the joystick in Audio MIDI Setup:
a) On the Pro Tools computer, navigate to Audio MIDI Setup (located at /Applications/Utilities/Audio/MIDI
Setup).
b) Double-click the Audio MIDI Setup application.
c) Click Window > Show MIDI Window.
d) Click Add Device.
e) Double-click on the new external device icon, and set properties for the device. (For example, give it
a device name of joystick or something similar.)
f) Click Apply.
g) On the screen, connect the MIDI out of the joystick device to the MIDI in of the USB MIDI interface.
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h) On the screen, connect the joystick to the USB MIDI interface by clicking the arrow for the joystick
output port (and holding the mouse button down), and then dragging an onscreen connection cable
to the input arrow of the USB MIDI device.
4. Obtain a suitable joystick. Dolby Atmos panner plug-ins were designed and tested with the JLCooper
MCS-Panner. You may substitute other devices.
5. Plug the MCS-Panner MIDI in and out cables into the USB MIDI interface MIDI out and in connectors,
respectively.

4.3.3 Preparing to use the JLCooper Axos
The JLCooper Axos is a plug-and-play USB device. Before you can use the JLCooper Axos to control a
panner, you must configure it in the panner plug-in.
Procedure
1. Open a panner plug-in window.
2. If configuration options are not displayed above the virtual room in the plug-in window, click the
configuration options button.

3. In the Object section, verify that there is an object number. If a new object number is needed, assign one.
4. In the Joystick Device section, use the joystick device input and output selectors to select JLCooper
Axos Panner as the input and output device.
5. Test the connection by moving the Axos (or using the Axos switches and knobs to determine other
panner behaviors). The yellow dot in the plug-in should move as the Axos is moved.
6. To close the configuration options section, click the configuration options button.
7. Repeat the preceding steps, and configure the JLCooper Axos in each of the remaining panner plug-ins in
the session.

4.3.4 Installing the JLCooper Eclipse PX joystick
Before you can configure the JLCooper Eclipse PX to control the panner, you must first install it on the
computer running Pro Tools.
Procedure
1. Download the latest JLCooper Nuage Panner/Eclipse PX software for Mac OS X from the
www.jlcooper.com.
The Eclipse PX is the same hardware as the Nuage panner for Yamaha/Steinberg mixing consoles. The
name of the installer package is Nuage Panner/Eclipse PX software for OS X version 1.0.3.
2. Launch the installer file, and follow the onscreen instructions to drag the panner icon into the
applications icon.
3. To connect the controller to your Mac through a router, perform these steps:
a) Connect the controller to your network router, and then turn on the controller.
b) In the Applications folder, locate the JLCooper Nuage Panner-Eclipse PX folder and open it.
c) Launch the JLCooper Nuage Panner-Eclipse PX setup application. If prompted with an error message
about installing required software components, ignore the message and press Go Back to resume
installation.
d) In the Nuage Panner/Eclipse PX Setup dialog, click (highlight) the network interface for your panner
and click Locate Panners to find your panner address, or, if you know your panner address, click
Manual IP Address and enter your address.
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e) Follow the onscreen instructions to finish connecting the software to your controller. When done,
click Finish. If you want to connect the controller directly to your computer through a dedicated
Ethernet port, refer to documentation included with the JLCooper Nuage Panner-Eclipse PX software
package.
4. Verify that the controller is an active MIDI device in the Apple Audio MIDI Setup utility:
a) On the Pro Tools computer, navigate to Audio MIDI Setup (located at /Applications/Utilities/Audio/MIDI
Setup).
b) Double-click the Audio MIDI Setup application.
c) Click Window > Show MIDI Studio.
d) If the controller is not present, close active windows and dialogs, and then reboot the Mac.
e) If the controller is present, but not active, press the Rescan MIDI button. When you launch Pro Tools,
the Eclipse PX shows Pro in its Pro display. The controller will be available in the Joystick Device
menu in the Dolby Atmos Panner plug-in after you insert the plug-in on a track.
What to do next
Configure the JLCooper Eclipse PX joystick.

4.3.5 Configuring a JLCooper Eclipse PX joystick in a panner plug-in
Before you can use a JLCooper Eclipse PX joystick to control a panner, you must configure the joystick in the
panner plug-in.
Prerequisites
Ensure that the JLCooper Eclipse PX joystick is installed on the computer running Pro Tools.
Procedure
1. Open a panner plug-in window.
2. If configuration options are not displayed above the virtual room in the plug-in window, click the
configuration options button.
3. In the Object section, verify that there is an object number. If a new input channel number is needed,
assign one.
4. In the Joystick Device section, use the joystick device input and output selectors to select Nuage
Panner/Eclipse PX as the input and output device.
5. Test the connection by clicking the button on top of the joystick, and then move the joystick. The yellow
dot in the plug-in should move as the joystick is moved.
6. Repeat the preceding steps, and configure the joystick in each of the remaining panner plug-ins in the
session.
7. To close the configuration options section, click the configuration options button.

4.4 Control surface and mixing console support
From a control surface or mixing console qualified by Dolby, you can map panner plug-in controls to
physical controls.
About this task
After mapping controls, you can then edit and automate parameters from the control surface or console.
Refer to your control-surface or console documentation for detailed information on how to use it to control
standard plug-in features.
You can use the panner with most control surfaces and mixing consoles that support page tables (such as an
Avid control surface).
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Table 1: Panner support by control surfaces and mixing consoles
Function

Avid D-Command and D-Control

x, y, and z position

Encoders, or faders (in Flip mode); or joysticks (x and y position
only); or Pro Tools Surround Panner joystick (x and y position, DControl only); or touch screen (x and y position, D-Control only)

Automatic z-axis panning with Elevation
Snap modes

Encoders, faders (in Flip mode), or joysticks; or touchscreen (DControl only)

x, y, and z position with stereo panner
plug-in linking

Encoders, faders (in Flip mode), or joysticks; or touchscreen (DControl only)

Elevation mode

Encoders or faders (in Flip mode)

Elevation Snap modes (for Sphere
Elevation, Wedge Elevation, or Ceiling
Elevation)

Encoders or faders (in Flip mode)

Speaker Snap mode

Encoders or faders (in Flip mode)

Zones

Encoders or faders (in Flip mode)

Focusing a panner plug-in

Select switches

Note: You can map panner plug-in controls to D-Command or D-Control encoders, faders, and B/M/P
switches (in custom faders and in channel strips only). You cannot map these controls to the
equalization (EQ) or dynamics section of a control surface.
Standard control surface features are supported by the panner plug-in, including:
•
•
•
•
•
•
•
•
•

Adding and removing plug-ins
Focusing (mapping) plug-in controls
Opening one or more plug-in windows onscreen
Targeting a plug-in window
Toggling plug-ins (inactive or active)
Changing plug-in presets from the channel strips
Copying and pasting plug-in settings
Enabling plug-in automation
Creating plug-in maps with Learn mode

Refer to your control-surface or console documentation for detailed information on how to use it to control
standard plug-in features.

4.5 Generic MIDI support
For panner plug-ins that support X, Y, Z, and size parameters, you can control the parameters with any
device that supports MIDI continuous-controller messages (such as a hexler TouchOSC remote controller).

Table 2: General MIDI support of panner plug-in parameters
Decimal CC #

Hex CC #

Panner plug-in parameter

10

0x0A

L/R pan (X-axis absolute)

11

0x0B

Front/back pan (Y-axis absolute)

12

0x0C

Floor/ceiling pan (Z-axis absolute)

13

0x0D

Size (absolute)
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5
Dolby Atmos Panner plug-in UI
The Dolby Atmos Panner plug-in window includes controls and displays to support automating
Dolby Atmos metadata for objects in Pro Tools for home theater content.
•
•
•
•
•

Dolby Atmos Panner virtual room
Operation mode buttons and zones selector
X/Y/Z sliders and position displays
Object size slider and value display
UI elements common to Dolby Atmos panner plug-ins
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5.1 Dolby Atmos Panner virtual room
The Dolby Atmos Panner provides a virtual room in its UI that is used when inputting panning position for an
object, or monitoring the object position during automation playback in Pro Tools.

Figure 2: Panner virtual room elements

Room outline

Zone indicators
(seven shown)

Pan location cursor
Left overhead

Right overhead

The virtual room includes:
•

•

•

Room outline: A bluish outline represents the walls of the room. The top of the virtual room represents
the front of the real room (where the screen and L, C, and R zones are located), and the bottom
represents the back. Left and right sides represent room left and right, respectively.
Zone and overhead indicators: Zone (or speaker zone) indicators and overhead (Elevation mode)
indicators display which speaker zones are active for an object in Dolby Atmos as the Renderer interprets
metadata from the Panner plug-in. Inversely, this feature is sometimes described as zone exclusion.
Zones are also used when the Renderer re-renders the Dolby Atmos mix to a surround format (such as 7.1
or 5.1 channels). You can use zones to isolate (or dedicate) an object to a specific speaker or group of
speakers. Zones are displayed as small blue squares in their relative position. Zones on the room outline
represent the L, R, C, sides, and rear speaker zones. Six zone configurations are available. Zones are
active (teal) or inactive (gray), based on the zones button setting. Additionally, two inner blue squares,
located on the x-axis, represent the overheads. They are active (teal) when Elevation mode or an
Elevation Snap mode is on; and inactive (gray) when Elevation mode or an Elevation Snap mode is off.
Pan location cursor: The pan location cursor provides the current position of the object in the room. You
can move the cursor with a joystick, control surface, mouse, or enabled automation. The pan location
cursor is represented by a yellow dot (located by default at the center of the virtual room). Depending on
the Elevation mode and positioning in the room, the cursor changes size: the cursor is larger when the
object is more elevated, and smaller when the object is less elevated. As the cursor is moved, the X, Y,
and Z sliders and position display values update accordingly. Inversely, the cursor moves when the X, Y,
and Z sliders or position display values are adjusted.
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•

Object size outline: The outline around the object displays the current spread of its audio in the room.
You can set the object size (level of spread) with the Dolby Atmos Panner plug-in UI, or a control surface,
mouse, or enabled automation. The outline changes size and direction based on the object size setting
and the object position and active speakers in the room.

The color of the area outside of the virtual room indicates the plug-in focus state. Blue indicates the plug-in
window (or channel in a stereo plug-in) is focused; gray indicates it is not. The focused plug-in channel is the
one controlled by the joystick.
Panner plug-ins automatically focus when you:
•
•

Open a plug-in window and touch a control (below the plug-in header).
Open a plug-in window, and click in the plug-in window (below the plug-in header).
Note: Panner plug-ins lose focus when you touch another window or dialog, including a Pro Tools
control outside of the plug-in (such as setting an Automation mode). To resume use of Panner plugin controls, refocus the plug-in.

5.2 Operation mode buttons and zones selector
The Panner plug-in window includes buttons and selectors for enabling or selecting common operation
modes and displaying their status.
Elevation mode button:
This button toggles Elevation mode on and off. Elevation mode allows for manual adjustment of the z
(top/bottom) dimension in the virtual room. When Elevation mode is off, you cannot adjust the z
coordinate, but previously written manual adjustments can be read.
Elevation Snap mode buttons:
These buttons let you toggle an Elevation Snap mode on or off, in order to change the shape of the
ceiling in the room, and in turn, how elevation drops as objects are panned away from the ceiling.
Speaker Snap mode button:
This button toggles Speaker Snap mode on and off. Speaker Snap mode moves object audio to the
active speaker nearest its established location during playback (for example, to eliminate phantom
panning). At the Renderer, this ensures that 100% of the audio signal is routed to the single speaker that
is nearest to the current spatial placement. Speaker Snap mode does not move the pan location cursor
in the virtual room.
Zones selector:
This selector lets you select one of six common speaker zone layouts, in order to activate or deactivate
specific speaker zones (for example, to isolate or dedicate an object to a specific group of speakers).

5.3 X/Y/Z sliders and position displays
The X/Y/Z sliders and displays let you adjust the location of an object in the virtual room, through all three
dimensions: x (left/right), y (front/back), and z (top/bottom).
•
•
•

X: Lets you control the left and right position of an object. The X range is –100 to 100. The default is 0.
Y: Lets you control the front and back position of an object. The Y: range is –100 to 100. The default is 0.
Z: Lets you control the height (top and bottom) position of an object. The Z range is 0 to 100. The default
is 0.
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5.3.1 Elevation and Z coordinate user-interface elements
In all Elevation modes or an Elevation Snap mode, the Z slider position, its display value, and the z
automation playlist match as expected.
These elements always represent the overhead level that is displayed in both the plug-in UI, and the Monitor
application. However, there are situations where the rendered audio output may not match the z position
being displayed. For example, if you disable Elevation mode after writing z automation, audio will play back
rendered without overheads, but the plug-in UI will continue to display the z automation.
There are also situations where the z automation UI and rendered audio output do not update during a write
automation pass as expected. If you enable an Elevation Snap mode during a write automation pass, the z
automation and elevation amount will not update until new automation data for the corresponding slider is
written. For example, when you enable Sphere Elevation Snap mode, updates occur after new x or y
automation data is written.
Note: After authoring Panner plug-in automation with Elevation mode or an Elevation Snap mode
on, you can edit the z automation data that was recorded by using a pencil tool in the z automation
playlist. The elevation defined by the new automation will be applied to the rendered object audio in
the subsequent playback as long as Elevation mode is enabled.

5.4 Object size slider and value display
The Object Size slider lets you spread audio for an object across the room, based on the current object
position and active speakers in the room.
You can use a joystick, control surface, mouse, enabled automation, or keyboard to adjust the size (or
spread). The object size outline, which surrounds the object cursor in the virtual room, shows the current
spread for an object. The object size has a range of 0 to 100.
Use object size to increase or decrease the number of loudspeakers used to render a particular object.
Object size spreads the audio for an object, as follows:
•
•
•

At 0, object size is effectively off, and audio routes to speakers based on the x/y/z position or Speaker
Snap mode.
At 100, audio spreads to all active speakers, regardless of the location of the cursor.
For values between 0 and 100, spreading is based on the object size, the object location, and the number
of active speakers.
Note: Object size is disabled when Speaker Snap mode is on.
Note: When using values between 50 and 100, audio may spread to all active speakers, regardless of
the location of the cursor. For example, if you have an object in the center of the room, with size = 51,
it is effectively the same as an object in the corner of the room with size = 100. Play with the object
size control starting from different room locations to see how object size spreads audio.
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Figure 3: Increasing object size from the room center

Dolby Atmos Panner Plug-in v2.5.x Guide
23 May 2019

28

Object size slider and value display

Figure 4: Increasing object size from a side wall

The object size value display provides the value of the current object size in the virtual room, whether
setting the size with a joystick, control surface, mouse, enabled automation, or keyboard entry.
Note: If the objectSize slider and value display are not visible at the bottom of the plug-in window,
click the Done button in the Configuration Options section to close the options and reveal the slider
and its value.

Dolby Atmos Panner Plug-in v2.5.x Guide
23 May 2019

29

Dolby Atmos Panner plug-in UI

5.5 UI elements common to Dolby Atmos panner plug-ins
All panner plug-ins include some common elements, such as an object-drop menu for assigning objects and
a configuration options button for accessing configuration controls and displays.

5.5.1 Object drop-down menu
Use the Object drop-down menu to assign an object panner to an available input channel that was assigned
an object in the Renderer input screen.
The Object drop-down menu is available in both the main panner window and the Object section of the
Configuration Options area.
You can manually assign objects to input channel numbers in the plug-in window, or autoassign object
channel numbers when inserting plug-ins with the Pro Tools all-selected shortcuts. Stereo tracks have two
displays and selectors, one for each mono subpath.

Figure 5: Object drop-down menu in a panner plug-in

The Object drop-down menu provides these menu choices and status information:
Input <number>: <description>
The plug-in is assigned to the displayed Renderer input channel that has an object and description.
None
This is the plug-in default state. The plug-in is not assigned to a Renderer input channel.
Input <number> (unavailable)
The plug-in was previously assigned to the displayed Renderer input channel, and the channel was
subsequently changed in the Renderer input screen to a bed or no assignment (--). To use the channel
with the panner, change the input configuration for the channel to an object (in the Renderer input
screen).
The input channel does not appear in the drop-down menu if an input channel in the input configuration is
set to a bed channel or no assignment and the plug-in was not previously assigned to the channel.

5.5.2 Configuration options button
The configuration options button accesses the configuration options area, which is useful for setting
common plug-in options and viewing the Renderer connection status.

When finished setting configuration options, click Done to close the options area and reveal the panner
sliders, their position display values, and the Linking selector (stereo only).
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5.5.3 Configuration options area
The Dolby Atmos Panner includes a configuration options area for setting common plug-in options and
viewing the Renderer connection status.
Configuration options button
The configuration options button opens (and closes) the Configuration Options area in panner plug-in
windows.
Configuration Options area
The Configuration Options area provides access to configuration controls.

Figure 6: Configuration Options area

Note: When the Configuration Options area is open, sliders and their position displays are not
visible at the bottom of the plug-in window. To reveal the sliders and their values, click the
configuration options button to close the Configuration Options area. Alternatively, you can resize
the window. (This will automatically close the Configuration Options area.)
Joystick Device section:
•
•

Device input drop-down menu: When configuring a joystick to control a Dolby Atmos Panner, use this
menu to set the joystick as the input device.
Device output drop-down menu: When configuring a joystick to control a Dolby Atmos Panner, use this
menu to set the joystick as the output device.

Object section:
•

Renderer connection status: This is the communication status between Dolby Atmos plug-ins in Pro
Tools and the Renderer software.

Figure 7: Renderer connection status in the Object section

The color of the IP address or host name denotes the status:
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Green
Renderer is connected.

•

Red
Renderer is not connected.
Object drop-down menu: Use this menu to determine which channel the panner is controlling. You can
assign an object panner to an available input channel that was assigned an object in the Renderer input
screen. This menu provides the same functionality as the Object drop-down menu in the panner plug-in
window (when the Configuration Options area is closed).
The Object drop-down menu provides these menu choices and status information:
Input <number>: <description>
The plug-in is assigned to the displayed Renderer input channel that has an object and description.
None
This is the plug-in default state. The plug-in is not assigned to a Renderer input channel.
Input <number> (unavailable)
The plug-in was previously assigned to the displayed Renderer input channel, and the channel was
subsequently changed in the Renderer input screen to a bed or no assignment (--). To use the channel
with the panner, change the input configuration for the channel to an object (in the Renderer input
screen).
The input channel does not appear in the drop-down menu if an input channel in the input configuration
is set to a bed channel or no assignment and the plug-in was not previously assigned to the channel.

5.5.4 Stereo panner Linking selector
The Linking selector setting for stereo panner plug-ins determines how the controls for the L and R channels
relate to each other.

Figure 8: Linking selector for a Production Suite stereo panner plug-in

Linking selector options:
None
The Left and Right channel controls operate completely independently. Actions taken in one channel
do not affect the other.
Mirrored
Any action in one channel automatically places its mirror image in the other. For example, panning from
center to the left in the Left channel produces a pan from center to right in the Right channel.
Copy
Any action in one channel is copied to the other. For example, panning from the center to the left in the
Left channel also produces a pan from center to left in the Right channel.

5.5.5 Resize window control
All Dolby Atmos panner plug-ins provide a control for resizing the plug-in window. The control is located at
the lower-right corner of the plug-in window and is shaded.
After you resize a panner plug-in window, the new size is applied to subsequently opened panner plug-ins
until you do a new resize.
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Dolby Atmos
Author Dolby Atmos material in a Pro Tools session configured for Dolby Atmos. You can create a
session from the template supplied by Dolby, or you can create your own.
•
•
•
•
•
•
•

Pro Tools session configured for Dolby Atmos rendering and mastering
Pro Tools session templates supplied by Dolby and configured for Dolby Atmos
Creating a Pro Tools session from the template supplied by Dolby
Creating your own Pro Tools session for Dolby Atmos
Channel assignments for Dolby Atmos plug-ins
Manually assigning an input channel number
Inserting multiple panner plug-ins and automatically assigning channels

Dolby Atmos Panner Plug-in v2.5.x Guide
23 May 2019

33

Setting up a Pro Tools session for Dolby Atmos

6.1 Pro Tools session configured for Dolby Atmos rendering and
mastering
To render Dolby Atmos content with the Renderer software, your Pro Tools session must be configured for
Dolby Atmos.

6.1.1 Session requirements
A Pro Tools session configured for Dolby Atmos has specific session requirements.
•

48 kHz or 96 kHz session sample rate

•

The Renderer supports 48 kHz and 96 kHz sessions only. If working with different sample rates during
sound creation or premixing, you need to change the session sample rate prior to working with the
Renderer.
Supported session timecode rate

•

The Renderer supports creating masters from sessions with these timecode rates: 23.976, 24, 25, 29.97,
29.97 drop frame, and 30 fps.
Hardware buffer size, dependent on the session sample rate
•
•

48 kHz session: 1,024 samples
96 kHz session: 2,048 samples

6.1.2 Track, plug-in, and routing configuration requirements
A Pro Tools session configured for Dolby Atmos has specific track, plug-in, and routing requirements.
•
•
•

input/output (I/O) setup (output and bus mapping) in Pro Tools configured for the Dolby Atmos bed and
objects.
Audio tracks with panner plug-ins inserted and set up so that they provide positioning and other
metadata.
Auxiliary input tracks with Dolby Renderer Send and Return plug-ins inserted and set up so that they
provide routing to and from the Dolby Atmos Renderer.

The session, in conjunction with the Renderer, lets you perform live monitoring of your Dolby Atmos mix,
record a master, or play back a master.

6.2 Pro Tools session templates supplied by Dolby and configured
for Dolby Atmos
The Dolby Atmos Renderer package includes Pro Tools session templates that let you create a session that is
configured and ready for Dolby Atmos authoring.

6.2.1 Session template locations and names
Dolby provides session templates for different authoring workflows.
Pro Tools session templates are installed at /Documents/Pro Tools/Session/Templates/Dolby Atmos Production Suite.
Template names are based on the system setup and number of Renderer channels the session supports.
•

Templates designed for systems using Send and Return plug-ins:

•

• Dolby Atmos Renderer Dolby Audio Bridge 32
• Dolby Atmos Renderer Send Return 32
• Dolby Atmos Renderer Send Return 64
Template designed for systems using the Dolby Audio Bridge:
•

Dolby Atmos Renderer Send Return 128
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6.2.2 Session template specifications
Each template includes tracks and plug-ins to support using the Dolby Atmos Renderer for live monitoring of
a Dolby Atmos mix, recording a master, and playing back a master.
The templates include:
•
•

I/O setup (output and bus mapping) in Pro Tools configured for the Dolby Atmos bed and objects
Audio tracks for beds and objects:
•
•

•

Bed tracks: The template provides one 7.1.2 multichannel track for bed material.
Object audio tracks: The template provides up to 118 mono audio tracks for objects, depending on
the template:

• Templates with 32 in their name support 22 objects.
• Templates with 64 in their name support 54 objects.
• Templates with 128 in their name support 118 objects.
Auxiliary input tracks with Dolby Renderer Send and Return plug-ins inserted and set up so that they
provide audio and metadata routing to and from the Dolby Atmos Renderer.
•

Dolby Renderer Send plug-ins inserted on auxiliary input tracks: These tracks are configured for a
Dolby Atmos mix using one 7.1.2 bed and up to 118 mono objects (depending on the template).
Dolby Renderer Return plug-ins inserted on auxiliary input tracks: These tracks are configured for
returning a headphone mix of rendered audio and 12 tracks designed to feed a room configured as
7.1.4.

•

Note: Pro Tools session templates supplied by Dolby and configured for Dolby Atmos do not include
return tracks that route re-render outputs from the Dolby Atmos Renderer. If needed, these tracks
must be created and configured with Dolby Renderer Return plug-ins.

6.3 Creating a Pro Tools session from the template supplied by
Dolby
Use a Pro Tools template supplied by Dolby to quickly create a session configured for Dolby Atmos.
Procedure
1. Launch Pro Tools.
2. Locate a session template supplied by Dolby, and create a new session from the template.
You can use the Pro Tools dashboard to locate and create a session from the template:
a)
b)
c)
d)
e)
f)
g)
h)
i)
j)
k)

If the Pro Tools dashboard does not display on launch, choose File > Create New.
In the dashboard, select the Create tab.
Set the Type to Session.
Click (check) the Create From Template option.
Click the Template Group drop-down menu, and select one of the pre-installed Dolby Atmos
templates.
If the template is not selected, click on it.
Name the session to be created from the template.
Make sure the Sample Rate is set to 48 kHz.
Make sure the H/W Buffer Size is set to 1024 Samples.
Change other options if needed.
Click the Create button.

3. Update the session configuration as needed.

Dolby Atmos Panner Plug-in v2.5.x Guide
23 May 2019

35

Setting up a Pro Tools session for Dolby Atmos

For example, you can replace some mono object tracks and panner plug-ins with stereo tracks and
stereo panner plug-ins.
4. Save the session.

6.4 Creating your own Pro Tools session for Dolby Atmos
You can create your own Dolby Atmos session, instead of using a Pro Tools session template supplied by
Dolby. To create a Pro Tools session for Dolby Atmos, create paths and tracks, add the Dolby Atmos plug-ins,
configure the beds and objects, set up the send and return tracks, and set up the outputs.
Prerequisites
•
•
•

Dolby Atmos Renderer and Pro Tools are open.
Dolby Atmos Renderer is configured with input and output settings.
New or existing Pro Tools session with a 48 kHz sample rate; hardware buffer size of 1,024 samples
(recommended).

About this task
This task creates a Pro Tools session for recording and monitoring a master.
Some rendering tasks do not require Dolby Renderer Send or Return plug-ins and the channels they would
be inserted on:
•
•
•

Playing back a master: Does not use Dolby Renderer Send plug-ins
Recording re-renders: Does not use Dolby Renderer Send plug-ins
Creating re-renders offline: Does not use Dolby Renderer Return plug-ins

Procedure
1. In the Pro Tools I/O setup, update the bus page with new paths to support a Dolby Atmos mix:
a) Add a 7.1 bus path with automatically created subpaths.
b) Add an overhead stereo path with automatically created subpaths.
c) Add paths for each object (up to 118 mono objects, or a combination of mono and stereo objects
totaling up to 118 object channel paths).
d) Verify that your left and right outputs are mapped to your system stereo outputs.
2. Create audio tracks for beds and objects:
a) Create one new 7.1 audio track, and name it 7.1 Bed.
b) Create one new stereo audio track, and name it OH Bed (for overheads).
c) Create up to 118 mono audio tracks, and name each track in sequential order (such as Object 1,
Object 2, and so on).
You can also create a combination of mono and stereo audio tracks totaling up to 118 channels, and
name each track in sequential order (such as Object 1, Object 2, and so on for mono tracks; Object 1-2
for stereo tracks).
3. Create auxiliary input tracks for sending audio and metadata to the Dolby Atmos Renderer:
a) Create one new 7.1 auxiliary input track, and name it 7.1 Bed Send.
b) Create one new stereo auxiliary input track, and name it OH Bed Send.
c) Create up to 118 mono auxiliary input tracks for the Dolby Atmos objects, and name them
accordingly, starting with the first object (for example, SND_OBJ_IN_1, SND_OBJ_IN_2, and so on).
Note: For stereo objects, create two auxiliary input tracks.
4. Configure the bed audio tracks, which provide the bed audio for your Dolby Atmos mix:
a) Set the output for the 7.1 bed track to its respective bus.
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b) Set the output for the overhead bed track to its respective bus.
5. Configure the object audio tracks, which provide the object audio and metadata for your Dolby Atmos
mix:
a) Open the Mixing page of the Pro Tools Preferences window, and click (enable) the Plug-in Controls
Default to Auto-Enabled option.
This eliminates the need to individually enable the plug-in parameters in each panner plug-in after
you insert them.
b) Set the output for each track to its respective bus. For example, for the track named Object 1, set the
output to bus 1.
c) Insert a panner plug-in on each object track.
The plug-in supports inserting panner plug-ins across multiple tracks at once.
d) In each panner plug-in, assign the plug-in to its respective input channel number and description (as
defined in the Renderer input screen). The plug-in supports assigning multiple panner plug-ins across
multiple tracks at once.
6. Configure the send (SND) tracks, which route audio to the Dolby Atmos Renderer:
Note: For Pro Tools HDX systems, use the DSP version of the Dolby Renderer Send plug-in. For
Pro Tools native systems, use the native version of the plug-in.
a) Set the input for each track to its respective bus path. For example, for the track named 7.1 Bed
Send, set the input to Path 1, and for the track named Object 1, set the input to Bus 1.
b) For the greater-than-stereo return track, insert a Dolby Renderer Send multimono plug-in.
c) For the stereo send track, insert a Dolby Renderer Send multimono plug-in.
d) For each mono send track, insert a Dolby Renderer Send mono plug-in.
e) In each Dolby Renderer Send plug-in, route the plug-in to its respective Renderer send channel.
For example, for the plug-in on the track named 7.1 Bed Send, set the plug-in to Send 1 (which
automatically sets the routing to Send 1 to Send 8, to cover bed channels for L, R, C, Low-Frequency Effects
(LFE), Lss, Rss, Lrs, and Rrs), for the stereo plug-in on track named OH Bed Send, set the plug-in to Send 9,
and for the plug-in on the first object track, set the plug-in to Send 11.
Note: When you are finished configuring the send tracks, you can hide them in Pro Tools, as you
will not need to see or change these tracks and their plug-ins during Dolby Atmos mixing.
7. Create and configure the return tracks that route rendered audio from the Dolby Atmos Renderer, and
then out of Pro Tools outputs for monitoring:
Note: For Pro Tools HDX systems, use the DSP version of the Dolby Renderer Return plug-in. For
Pro Tools native systems, use the native version of the plug-in.
a) Create two mono auxiliary tracks for returning a binaural mix of rendered audio from the Dolby
Atmos Renderer, and name the tracks Headphone L and Headphone R.
b) Set the output of the headphone return tracks to route to your system stereo left and right outputs,
respectively.
c) Create up to 22 mono auxiliary input tracks for returning rendered speaker audio from the Dolby
Atmos Renderer, and name them accordingly (such as RTN_SPK_1).
d) Set the output of each speaker return track to an available Pro Tools output. This provides speaker
monitoring.
Note: Monitoring is available only when the Speaker monitoring option is set to on.
e) For each mono return track, insert a Dolby Renderer Return mono plug-in.
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f) For stereo return tracks, insert a Dolby Renderer Return multimono plug-in on the first stereo return
track, unlink the L and R channel in the plug-in (using the Master Link button), and then copy
(Option-drag) the plug-in to any other stereo return tracks.
g) For greater-than-stereo return tracks, insert Dolby Renderer Return multimono plug-ins in each
greater-than-stereo multichannel track, and then unlink the channels in each plug-in (using the
Master Link button in the plug-in).
h) In each Dolby Renderer Return plug-in, route the plug-in to its respective Renderer output channel.
For example, for the plug-in on the track named Headphone Left, route to Headphone L, and for the
plug-in on the track named RTN_SPK_1, route to Speaker Channel 1.
Note: Ensure that Dolby Renderer Return plug-ins on multichannel tracks have their channels
unlinked in the plug-in prior to routing them. When channels are linked, routing selections are
ignored.
8. Create and configure the return tracks that route re-render outputs from the Dolby Atmos Renderer, and
then out of Pro Tools outputs (for monitoring) or bussed to audio tracks (for recording):
Note: Pro Tools session templates supplied by Dolby and configured for Dolby Atmos do not
include return tracks that route re-render outputs from the Dolby Atmos Renderer. If needed,
these tracks must be created and configured with Dolby Renderer Return plug-ins.
a) Create up to 64 mono auxiliary input tracks for returning and recording re-render audio from the
Dolby Atmos Renderer, and name them accordingly (such as RTN_RR_1).
b) Set the output of each re-render return track to an available Pro Tools output (for monitoring) or bus
the audio to an available audio track (for recording).
c) For each mono return track, insert a Dolby Renderer Return mono plug-in.
d) For stereo return tracks, insert a Dolby Renderer Return multimono plug-in on the first stereo return
track, unlink the L and R channel in the plug-in (using the Master Link button), and then copy
(Option-drag) the plug-in to any other stereo return tracks.
e) For greater-than-stereo return tracks, insert Dolby Renderer Return multimono plug-ins in each
greater-than-stereo multichannel track, and then unlink the channels in each plug-in (using the
Master Link button in the plug-in).
f) In each Dolby Renderer Return plug-in, route the plug-in to its respective Renderer output channel.
For example, for the plug-in on the track named RTN_RR_1, route to Re-render Channel 1.
Note: Ensure that Dolby Renderer Return plug-ins on multichannel tracks have their channels
unlinked in the plug-in prior to routing them. When channels are linked, routing selections are
ignored. If you subsequently relink the channels, the routing is reset to None.
9. Save the session.

6.4.1 Considerations when inserting panner plug-ins in Pro Tools
In Pro Tools, you can insert panner plug-ins on mono or stereo tracks that are identified as Dolby Atmos
objects.
Note: When Pro Tools plug-ins are organized by category, the panner plug-in is located in the Sound
Field submenu. When organized by company, it is in the Dolby Laboratories submenu.
You can insert panner plug-ins individually, or on multiple tracks simultaneously (using the Pro Tools allselected shortcut):
•
•

When you insert panner plug-ins individually on tracks, Renderer input channel numbers are not
assigned. This means that the plug-in is disabled until an input channel number is assigned to it.
When you insert panner plug-ins using the Pro Tools all-selected shortcut, you can choose how to
autoassign input channel numbers. For example, you can choose to not autoassign input channel
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numbers in the new plug-ins, or to autoassign new numbers across new and old plug-ins, or new plug-ins
only.
You must assign a Renderer input channel number to a plug-in to enable it. This number is used by the Dolby
Atmos Renderer to identify the object and render its metadata. Stereo plug-ins have two input channel
number assignments, one for each mono subpath.
You can manually assign Renderer input channel numbers in the plug-in window, or autoassign input
channel numbers when inserting plug-ins with the Pro Tools all-selected shortcut. Inserting plug-ins across
multiple tracks and autoassigning input channel numbers will save you time and simplify the process of
adding panner plug-ins to your Dolby Atmos sessions.
For consistency and ease of use, you should insert all panner plug-ins in the same insert position (for
example, at the beginning or end of the inserts chain). This also makes it easier to display the knobs on a
control surface.
Note: Typically, you should align the input channel number assignment with your track name and
the number used to name the channel path or subpath. This will help create a logical and consistent
numbering and naming scheme.
For example, insert the first plug-in on a track named Object 1 (for a mono track) or on a track
named Object 1–2 (for a stereo track).

6.5 Channel assignments for Dolby Atmos plug-ins
Channel assignments for Dolby Atmos plug-ins are based on the plug-in type and routing path.
Panner plug-ins
These plug-ins route metadata to the Renderer input (via the Render Send plug-in). The available object
numbers and the descriptions for objects are based on the objects and descriptions configured in the
Renderer input screen. None disables the plug-in. When a plug-in is inserted on a single track, or
inserted with multiple plug-ins and no automatic assignments, the channel assignment defaults to
None.
Dolby Renderer Send plug-in
This plug-in routes audio to the Renderer input. The available input channels, input type (beds or
objects), and descriptions for each bed and object are based on the input types and labeling configured
in the Renderer input screen. The list of available channels includes inputs 1 - 118. In the UI, each
available bed and object channel is preceded by Bed Channel and Object Channel, respectively.
Dolby Renderer Return plug-in
This plug-in routes rendered audio from the Renderer output back to Pro Tools. The list of available
channels includes speaker channel 1 - 22, headphone L and headphone R, and re-render channel 1 - 64.

Table 3: Channel order for input channels
Pro Tools track output paths (I/O setup bus
channels)

Renderer Send channel inputs

L

L

C

R

R

C

Lss

LFE

Rss

Lss

Lsr

Rss

Rsr

Lrs
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Table 3: Channel order for input channels (continued)
Pro Tools track output paths (I/O setup bus
channels)

Renderer Send channel inputs

LFE

Rrs

L (left overhead)

Lts (left overhead)

R (right overhead)

Rts (right overhead)

C, or L, R (objects 1 to 118)

C, or L, R (objects 1 to 118)

6.6 Manually assigning an input channel number
Manually assign a channel to enable a single plug-in that does not have an assignment, or to change an
existing channel assignment to another assignment.
Procedure
1. Open the Panner plug-in window.
2. Click the object drop-down menu, and select a channel.

Figure 9: Clicking an object drop-down menu in a panner plug-in

Currently used numbers appear in gray and are not available.

Figure 10: Selecting a channel in a panner plug-in window

6.7 Inserting multiple panner plug-ins and automatically assigning
channels
Insert multiple panner plug-ins at once, and automatically assign channels to save time.
About this task
Panner plug-ins can be inserted to the same insert position in all selected tracks using the standard Pro
Tools all-selected shortcut.
When you insert panner plug-ins using the Pro Tools all selected shortcut, you can choose how to autoassign
numbers across new and existing plug-ins. For example, you can choose to not autoassign object numbers
in the new plug-ins, or to autoassign new numbers across new and old plug-ins, or new plug-ins only.
When working with sessions that have mono and stereo plug-ins, consider placing all plug-ins of the same
width together as a set, and first performing autoassignment of the first set, and then the second set, to
maintain sequential numbering from the first plug-in to the last
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Procedure
1. Choose (highlight) one or more track names.
2. Option + Shift-click a plug-in selector, and while still holding down the keys, select the plug-in.
3. In the dialog, choose an autoassign option.

6.7.1 Autoassign options
When inserting Dolby Atmos plug-ins with the Pro Tools all-selected shortcut, autoassignment options are
provided.
The autoassignment options include:
None
Choose this option to autoassign no channels to plug-ins. New plug-ins are not assigned channels.
Existing plug-ins are unaffected and retain their channel assignments.
Overwrite existing
Choose this option to autoassign channels to all plug-ins. All panner plug-ins are assigned (or
reassigned) the next available input channel number for a mono object (or the next two available
numbers for a stereo object). Assignments are made in track sequential order (left to right, or top to
bottom). Existing plug-ins are affected, depending on where they are located in the session.
Preserve
Choose this option to autoassign channels to new plug-ins only. Each new panner plug-in is
autoassigned the next available input channel number for a mono object (or the next two available
numbers for a stereo object). Assignments are made in track sequential order (left to right, or top to
bottom). Existing plug-ins are unaffected and retain their object numbers.
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Glossary
DSP
Digital signal processor. A specialized microprocessor optimized for digital signal processing.
fps
Frames per second. The number of unique consecutive audio or video frames an audio or imaging
device produces in one second.
frame
In audio, a series of PCM samples or encoded audio data representing the same time interval for all
channels in the configuration. Metadata pertaining to the frame can be carried within the frame or
separately, depending on context.
I/O
Input/output. The communication between a system and an entity outside the system, such as another
system or a human being.
IP address
Internet Protocol address. A numerical identifier assigned to a device that is a member of a network that
uses the IP for communication.
LFE
Low-Frequency Effects. A band-limited channel specifically intended for deep, low-pitched sounds.
object
An audio signal plus associated object audio metadata.
rendering
Processing of audio content to adapt it to specific speaker layouts, such as 5.1‑ and 7.1‑speaker feeds,
or headphones and sound bars.
UI
User interface.
USB
Universal Serial Bus. A standard that defines the cables, connectors, and communications protocols
used in connections between computers and electronic devices.
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